The Graduate Council met at 3:00 p.m. on January 12, 2015, in McCain Library, Room 203 with Dr. Douglas Rust, Chair of the Graduate Council, presiding.

The following voting members were present: Dr. Wendy Adkins-Sayre, Dr. Jonathan Barron, Dr. Brian J. Collins, Dr. Janie Butts, Dr. Dana Fennell, Dr. Bonnie Nicholson, Dr. Ras Pandey, Dr. Scott Piland, Dr. Douglas Rust, Dr. Jake Schaefer, Dr. Kyna Shelley, Dr. Amy Slagle, Dr. Teresa Welsh and Dr. Mike Wittmann.

The following voting members were represented by proxies to constitute a quorum: Dr. Bonnie Nicholson for Dr. James Lambers.

The following non-voting members were present: Dr. Jeannie Gillespie for Dr. Steven Moser, Dr. Diane Fisher for Dr. Ann Blackwell, Dr. Karen Coats. Ms. Emmalea Gomberg, and Dr. Bill Powell.

The following guests were present: Ms. Desira Bailey, Dr. Ann Marie Kinnell, Dr. Alicia Landry, Ms. Kathryn Lowery, Dr. Doug Masterson, Ms. Dawn Porter and Dr. Kathy Yadrick.

1.0 Call to Order
Dr. Rust called the meeting to order at 3:00 p.m.

2.0 Adoption of Agenda
Dr. Rust presented the agenda with for approval. Dr. Wittmann moved and Dr. Nicholson seconded a motion to approve the agenda. The motion passed.

3.0 Approval of Minutes
Dr. Rust presented the November 17, 2014 minutes for approval. Dr. Wittmann moved and Dr. Piland seconded a motion to approve the November 17, 2014 minutes. The motion passed.

4.0 Course and Program Proposals
4.1 College of Arts & Letters
   Department of Anthropology and Sociology
   Dr. Rust presented the request to modify the certificate in Nonprofit Studies. Dr. Collins moved and Dr. Wittmann seconded a motion to approve the modification of the certificate in Nonprofit Studies. The motion passed.

4.2 College of Business
   School of Accountancy
   Dr. Rust presented the request to modify ACC 598. Dr. Wittmann moved and Dr. Piland seconded a motion to approve the modification of ACC 598. The motion passed.
Department of Finance, Real Estate and Business Law
Dr. Rust presented the request to modify FIN 598 and REI 598. Dr. Wittmann moved and Dr. Collins seconded a motion to accept these courses as a group. The motion passed. Dr. Piland moved and Dr. Collins seconded a motion to approve the modification of FIN 598 and REI 598. The motion passed.

Department of Management and International Business
Dr. Rust presented the request to modify IB 598 and MGT 598. Dr. Wittmann moved and Dr. Collins seconded a motion to accept these courses as a group. The motion passed. Dr. Wittmann moved and Dr. Piland seconded a motion to approve the modification of IB 598 and MGT 598. The motion passed.

Department of Marketing and Merchandising
Dr. Rust presented the request to modify MKT 598. Dr. Wittmann moved and Dr. Collins seconded a motion to approve the modification of MKT 598. The motion passed.

Dr. Rust presented the request to modify the MBA Program emphasis name. Dr. Collins moved and Dr. Schaefer seconded a motion to approve the modification of the MBA Program emphasis name. The motion passed.

College of Education and Psychology
Department of Curriculum, Instruction and Special Education
Dr. Rust presented the request to modify IT 567 and IT 569. Dr. Collins moved and Dr. Fennell seconded a motion to accept these courses as a group. The motion passed. Dr. Butts moved and Dr. Wittmann seconded a motion to approve the modifications of IT 567 and IT 569. The motion passed.

College of Health
School of Human Performance and Recreation
Dr. Rust presented the request to rename the Academic Unit of the School of Human Performance and Recreation. Dr. Wittmann moved and Dr. Collins seconded a motion to approve the renaming of the Academic Unit of the School of Human Performance and Recreation. The motion passed.

Dr. Rust presented the request to modify the course prefix of all HPR courses. Dr. Nicholson moved and Dr. Wittmann seconded a motion to approve the modification of the course prefix of all HPR courses.
Dr. Rust presented the request to modify the Human Performance (Exercise Science) M.S. degree program, the Human Performance (Physical Education) M.S. degree program, the Human Performance (Biomechanics) Ph.D. degree program, the Human Performance (Exercise Physiology) Ph.D. degree program, and the Human Performance (Sport Pedagogy) Ph.D. degree program. Dr. Wittmann moved and Dr. Collins seconded a motion to accept these degree programs as a group. The motion passed. Dr. Wittmann moved and Dr. Piland seconded a motion to approve the modifications of the Human Performance (Exercise Science) M.S. degree program, the Human Performance (Physical Education) M.S. degree program, the Human Performance (Biomechanics) Ph.D. degree program, the Human Performance (Exercise Physiology) Ph.D. degree program, and the Human Performance (Sport Pedagogy) Ph.D. degree program. The motion passed.

Department of Nutrition and Food Systems
Dr. Rust presented the request to add NFS 520L. Dr. Wittmann moved and Dr. Collins seconded a motion to approve the addition of NFS 520L. The motion passed.

Dr. Rust presented the request to modify NFS 585 and NFS 586. Dr. Piland moved and Dr. Wittmann seconded a motion to accept these courses as a group. The motion passed. Dr. Collins moved and Dr. Wittmann seconded a motion to approve the modifications of NFS 585 and NFS 586. The motion passed.

4.5 College of Nursing – No Business

4.6 College of Science and Technology
Department of Chemistry and Biochemistry
Dr. Rust presented the request to modify CHE 509. Dr. Schaefer moved and Dr. Piland seconded a motion to approve the modification of CHE 509. The motion passed.

Department of Biological Sciences
Dr. Rust presented the request to modify BSC 563. Dr. Piland moved and Dr. Wittmann seconded a motion to approve the modification of BSC 563. The motion passed.

5.0 Officers Report
5.1 Chair – Dr. James Lambers
No report.

5.2 Chair-Elect – Dr. Douglas Rust
No report.
6.0 Standing Committee Reports
6.1 Bylaws Committee – Dr. Kyna Shelley
   No report.

6.2 Credentials Committee – Dr. Jake Schaefer
   Dr. Schaefer submitted the Credentials report for January 2015 for approval. The report was approved. (see attached)

6.3 Election Committee – Dr. Douglas Rust
   No report.

6.4 Policies and Procedures Committee – Dr. Bonnie Nicholson
   No report.

6.5 Program Review Committee – Dr. Janie Butts
   No report.

7.0 Liaisons to University Committees
7.1 Assessment Committee- Dr. Douglas Rust
   No report.

7.2 E-Learning Committee- Dr. James Lambers

7.3 Teaching Evaluation Committee – Dr. Bonnie Nicholson
   Dr. Nicholson reported the committee on the evaluation of teaching approved last year a policy recommendation which goes in place beginning Jan 1, 2015 allowing chairs access to both student comments and numerical ratings on evaluations. The committee is developing a set of implementation recommendations, plans to communicate a desire for an appeals process be added to the handbook and will take under advisement a request made by student government to add a midterm evaluation option to the course evaluation system.

7.4 Strategic Planning Committee – Dr. Bonnie Nicholson
   Dr. Nicholson reported the Strategic Planning Committee has made some available a draft version of the Mission, Vision, and Values revisions to the President and Cabinet members and has plans to circulate a final draft to the University Community early this semester. Strategic initiatives are being drafted. Colleagues are strongly encouraged to be sure to weigh in on these drafts once circulated.

8.0 New Business
8.1 Dean’s Report
   Dr. Coats presented a report to Council. (See attached)

8.2 Graduate Student Senate Report
   Ms. Gomberg presented a report to Council. (See attached).
9.0 Announcements

10.0 Adjournment
The meeting was adjourned. The next meeting is scheduled for February 9, 2015 at 3:00. The deadline for submitting materials to the Graduate School for the Agenda is Friday, January 23, 2015.

___________________________  ____________________________
Greg Pierce, Recording Secretary  Dr. Douglas Rust, Chair - Elect
College of Arts and Letters
Department of Anthropology and Sociology

Modify: Certificate in Nonprofit Studies.
Change of location (Hattiesburg and Gulf Coast)

To: Certificate in Nonprofit Studies.
Change of location (Hybrid-Online designation only)
Effective summer 2015.

College of Business
School of Accountancy

Modify: ACC 598 International Accounting Seminar Abroad.

To: ACC 598 International Accounting Seminar Abroad.
Bulletin description.
Effective summer 2015.

Department of Finance, Real Estate and Business Law

Modify: FIN 598 International Finance Seminar Abroad.

To: FIN 598 International Finance Seminar Abroad.
Bulletin description.
Effective summer 2015.

Modify: REI 598 International Insurance Seminar Abroad.

To: REI 598 International Insurance Seminar Abroad.
Bulletin description.
Effective summer 2015.

Department of Management and International Business

Modify: IB 598 International Business Seminar Abroad.

To: IB 598 International Business Seminar Abroad.
Bulletin description.
Effective summer 2015.
<table>
<thead>
<tr>
<th>Modify:</th>
<th>MGT 598</th>
<th>International Management Seminar Abroad.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td>MGT 598</td>
<td>International Management Seminar Abroad.</td>
</tr>
</tbody>
</table>

**Department of Marketing and Merchandising**

<table>
<thead>
<tr>
<th>Modify:</th>
<th>MKT 598</th>
<th>International Marketing Seminar Abroad.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td>MKT 598</td>
<td>International Marketing Seminar Abroad.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modify:</th>
<th>Business Administration (One year) MBA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td>Business Administration MBA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Effective summer 2015.</td>
<td></td>
</tr>
</tbody>
</table>

**College of Education and Psychology**

*Department of Curriculum, Instruction and Special Education*

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td>IT 567</td>
<td>Digital Publishing and Visual Design.</td>
</tr>
<tr>
<td></td>
<td>Face to face format.</td>
<td>Face to face and online correspondence format.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Modify:</th>
<th>IT 569</th>
<th>Multimedia Design and Development.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td>IT 569</td>
<td>Multimedia Design and Development.</td>
</tr>
<tr>
<td></td>
<td>Face to face format.</td>
<td>Face to face and online correspondence format.</td>
</tr>
</tbody>
</table>
Modify:  
School of Human Performance and Recreation.

To:  
School of Kinesiology.
Effective fall 2015.
Pending IHL approval.

Modify:  
HPR prefix

To:  
KIN prefix
Effective fall 2015.
Pending IHL approval.

Modify:  
Human Performance (Exercise Science) M.S. degree program.

To:  
Kinesiology (Exercise Science) M.S. degree program.
Effective fall 2015.
Pending IHL approval.

Modify:  
Human Performance (Physical Education) M.S. degree program.

To:  
Kinesiology (Physical Education) M.S. degree program.
Effective fall 2015.
Pending IHL approval.

Modify:  
Human Performance (Biomechanics) Ph.D. degree program.

To:  
Kinesiology (Biomechanics) Ph.D. degree program.
Effective fall 2015.
Pending IHL approval.

Modify:  
Human Performance (Exercise Physiology) Ph.D. degree program.

To:  
Kinesiology (Exercise Physiology) Ph.D. degree program.
Effective fall 2015.
Pending IHL approval.

Modify:  
Human Performance (Sport Pedagogy) Ph.D. degree program.

To:  
Kinesiology (Sport Pedagogy) Ph.D. degree program.
Effective fall 2015.
Pending IHL approval.
Add:

**NFS 520L**

Lifecycle Nutrition Lab.
1 hour. Effective fall 2015.

Modify:

**NFS 585**

Medical Nutrition Therapy II.
2 hours.

To:

**NFS 585**

Medical Nutrition Therapy II.
3 hours.
Effective fall 2015.

Modify:

**NFS 586**

Medical Nutrition Therapy III.
2 hours.

To:

**NFS 586**

Medical Nutrition Therapy III.
3 hours.
Effective fall 2015.

---

**College of Science and Technology**

**Department of Chemistry and Biochemistry**

Modify:

**CHE 509**

Chemistry Laboratory Teaching.
1 hour.

To:

**CHE 509**

Chemistry Laboratory Teaching.
3 hours.
Effective fall 2015.

Modify:

**BSC 563**

Pathobiology.
2 hours.

To:

**BSC 563**

Pathobiology.
3 hours.
Effective fall 2015.
DATE: January 12, 2015  
TO: Graduate Council  
FM: Graduate Credentials Committee  
RE: Graduate Faculty Recommendations

<table>
<thead>
<tr>
<th>Name</th>
<th>Department</th>
<th>Recommendation Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Herrington, Britty</td>
<td>Curriculum, Instruction, &amp; Special Education</td>
<td>A1</td>
</tr>
<tr>
<td>Weber, Diana</td>
<td>Biological Sciences</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td><strong>Associate Level 2</strong></td>
<td></td>
</tr>
<tr>
<td>Elliott, Katherine J.</td>
<td>Coastal Sciences</td>
<td>A3</td>
</tr>
<tr>
<td></td>
<td><strong>Associate Level 3</strong></td>
<td></td>
</tr>
<tr>
<td>Anestis, Joye C.</td>
<td>Psychology</td>
<td>R3</td>
</tr>
<tr>
<td></td>
<td><strong>Regular Level 1</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Regular Level 2</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Regular Level 3</strong></td>
<td></td>
</tr>
</tbody>
</table>

Credentials Committee Chair  
Respectfully submitted,
The document below describes the policies currently being considered by the Policies and Procedures committee. These are in DRAFT form and have not been approved by the committee. The suggested plan and timeline is described below.

- **December 2014** – develop DRAFT policy document (see below for developing draft)
- **January 2015** – submit to Graduate Council as a first read
- **February 2015** – revise based on feedback from Council; distribute revised, draft policy to Dept Chairs and Program Directors for input (develop online feedback portal using Mach forms or Qualtrics; Committee to revise based on feedback received)
- **March 2015** – submit revised draft to Graduate Council; vote on each item separately. Policy recommendations will pass by majority vote. Specific wording and implementation of policy is left to the discretion of the Graduate School.

**Policy Considerations are described below:**

1. **Grade Policy** recommendations:
   1. Students must maintain a cumulative 3.0 GPA, or be placed on probation.
   2. Students earning more than two grades C’s or any grades lower than a C will be placed on probation. Students can have no more than 1 grade below a C on their transcript or are considered for dismissal. Students can earn no more than 3 C’s or are considered for dismissal.
   3. Students on probation have one semester to raise the GPA to a 3.0; students are expected to earn no less than a B- on subsequent coursework while on probation.
   4. Program directors/Chairs will be notified before the graduate school takes any action on a student’s status in the program. Students on probation must file with the Graduate School a plan detailing the steps necessary to be removed from probation and a proposed timeline. This should be approved and signed by the student, the program director, and department chair.
   5. Departments/programs can set more stringent grade and probationary policies.

2. **Required Application Deadlines**
   The Committee recommends that the Graduate School require that each program have posted application deadlines. Individual programs should negotiate deadlines with the Graduate School.

3. **Non-degree Course Policy Recommendations**:
   We suggest that the credit hour limitations in place for Master’s degrees (see items B-D in the current Graduate Bulletin) also be extended to doctoral degrees.
   
   B. A total of no more than twelve (12) semester hours of work earned as a non-degree student may be applied toward a doctoral degree. Please note D below.
   
   C. As many as six (6) semester hours of graduate credit from other accredited institutions may be transferred to the student’s program with the approval of the appropriate department chair and
dean of the Graduate School provided that the course work transferred falls within the five-year period allowed for the degree. Such course work must carry a letter or numeric grade of "B" or better and not counted toward another graduate degree and cannot be a pass/fail course. The transfer grade is not calculated in the USM GPA.

D. A total sum of no more than twelve (12) semester hours of transfer work and non-degree work may be applied toward a doctoral degree.

4. **Policies Regarding Deferment**

We suggest the Graduate School not place a limit on deferments, but is empowered to adjust fees regarding multiple deferments to discourage such practices.

5. **Policies Regarding Probation**

We suggest the Graduate School consider the following limitations related to students on probation: Students must be in good standing in order to engage in progress toward degree activities which include Propose a Thesis or Dissertation, Defend a Thesis or Dissertation, and participate in Qualifying or Comprehensive Examinations.

6. **Policies Regarding Certificate Programs**

The Graduate School should develop an enrollment process for Graduate Certificates as currently no standard procedures are in place to allow degree-seeking or non-degree students a mechanism to enroll in a certificate program. It is assumed that these do not need to be subject to the same admission criteria as other graduate programs and can be left to the discretion of the department offering the certificate and filed with the graduate school using the Plan of Study (to be developed) specific to that Graduate Certificate.

I. **Credit Hours**

A minimum of twelve semester hours credit is required for any graduate certificate. Many departments require more than the minimum. Consult specific departmental requirements for additional information. A 3.0 GPA in the certificate program and no grade below a "C" are required for completion. Some departments require a higher GPA and restrict the number of "C" grades for graduation.

II. **Plan of Study Form**

Students must submit a "plan of study" form to The Graduate School by their first semester of enrollment. See [www.usm.edu/graduateschool/planofstudy](http://www.usm.edu/graduateschool/planofstudy).

III. **Time Limitation**

The student must complete the graduate certificate within four calendar years from the date of initial enrollment in a certificate program. Four years is the maximum age allowed for graduate credits toward a graduate certificate. The dean of the Graduate School, under extenuating circumstances, and special petition, may approve revalidation of some over-age credit hours if the original credit was earned at The University of Southern Mississippi and if the department chair approves the revalidation. The revalidation is secured by the student's successfully passing a special examination on the course. However, any student who fails to complete the certificate program within the four-year time period becomes subject to any changes in degree requirements made at any date four years prior to graduation. The fee charged for the special revalidation examination is to be paid before the revalidation examination is taken. Over-age
extension and transfer courses cannot be revalidated. Revalidation forms are available in The Graduate School.

IV. **Credit Hours Limitations**
   A. No more than three (3) semester hours of graduate credit from other accredited institutions may be transferred to the student's program with the approval of the appropriate department chair and dean of the Graduate School provided that the course work transferred falls within the four-year period allowed for the degree. Such course work must carry a letter or numeric grade of "B" or better and not counted toward another graduate degree and cannot be a pass/fail course. The transfer grade is not calculated in the USM GPA.

V. **Research and Scholarly Integrity Education**
   All graduate students must complete the RSIE training modules required by the Graduate School and their departments the first semester they are enrolled in graduate school. The RSIE policy and training information are found on the Graduate School web page – [www.usm.edu/graduate school](http://www.usm.edu/graduate school). Contact the Dean of the Graduate School if you have any questions regarding the policy of training information. The RSIE completion certificate is good for 5 years.

VI. **Application for Degree and Audit**
   Students should submit to the graduate degree auditor a signed, completed application for degree by the specified deadline the semester before they wish to graduate. The graduate degree auditor will check the application and notify the student and his or her adviser of any problems. (See [www.usm.edu/graduateschool](http://www.usm.edu/graduateschool) for specific directions and deadlines). Students who do not graduate the semester for which they applied must contact the graduate degree auditor, submit a deferment form, and pay a deferment fee.

7. **Policies Concerning Dissertation**
   a. Graduate Committee Membership
      i. 3-4 members Thesis
      ii. 4-5 members Dissertation
      iii. Need simple majority vote to pass.
   b. Credit hour requirements
      i. Students should be enrolled in at least 1 credit the semester they defend and have to have met all credit hour requirements (3-6 Thesis; 9-12 Dissertation).

8. **Continuous Enrollment**
   a. Part time enrollment should be permitted by the Graduate School but may be disallowed by specific department policies. While adhering to the standard time to completion policies, students need not be continuously enrolled while they are completing coursework. Upon completion of all coursework and until the completion of any final, capstone project, thesis, or dissertation, students need to be continuously enrolled for at least one credit each semester until the semester they graduate.

9. **Course numbering system**
   a. All graduate courses which have an undergraduate counterpart (e.g., split level courses) should be appropriately numbered using the standard numbering system found in the Graduate Bulletin (check to be sure this is IN the bulletin – I know it is on the transcript).
Therefore split level courses should be 400/500; any deviations from this practice require sufficient justification beyond convenience.

10. **Repeated Courses to Replace Poor Grades**

   a. Recommend clarifying the number of courses which can be replaced at the graduate level. *(ask for more input – needs discussion from GC)*

11. **Dual Degree**

    Consider proposal to allow for students to be enrolled in more than one degree program.

12. **Admission standards**

    a. Consider a proposal to allow programs to petition to waive the standardized testing requirement.

       i. The expectation is that the Graduate Bulletin will continue to reflect an expectation that a standardized testing requirement be in place for admission to all graduate programs.

       ii. Individual programs can petition the Graduate Council for an exception to this policy by detailing the specific method of application review used, a clear rationale for the exception, and the instances where the exception may be granted.
Hugh Broome, a doctoral student in the Department of Chemistry and Biochemistry, enjoys sharing his enthusiasm for chemistry with other scientists and educators. During the Fall 2014 semester he assisted visiting doctoral student Kathryn Kellett, a Winston Churchill Fellow from the University of Hertfordshire, United Kingdom. Kellett visited USM to collaborate with Dr. Karl Wallace, Associate Professor in the Department of Chemistry and Biochemistry. Her goal was to develop sensors for “designer drugs”. Broome’s role was to design the sensors using Kellett’s theoretical calculations and protein models. For more information see the December 16, 2014 article in Southern Miss Now (http://www.usm.edu/news/article/winston-churchill-fellow-collaborates-southern-miss-researchers-designer-drug-detection). In addition, Broome was named an American Chemical Society Science Coach for the 2014-15 school year, along with colleagues Emily Matthews and LaCrissia Bridges. Science Coaches “are chemistry professionals who share their expertise and enthusiasm for science with an elementary, middle, or high school teacher over course of one school year” (ACS, http://www.acs.org/content/acs/en/education/outreach/science-coaches.html).
Graduate School Staff Changes
Ms. Emily Lymon is the new Senior Graduate Admissions Specialist in the Graduate School, beginning her new role in early December. Emily served as Admissions Specialist in the Graduate School since January 2014 and worked for 5 years as Information Specialist in the Office of Undergraduate Admissions. She was selected in a competitive search from a pool of 34 candidates. Emily’s experience in admissions at both the graduate and undergraduate levels will be a valuable asset in her new role. We welcome her to her new position.

Professional Development Opportunities for Students and Faculty

1. Graduate Research Symposium
   - The abstract deadline for the 2015 Susan A. Siltanen Graduate Student Research Symposium (to be held March 25 from 9 AM to 5 PM at the Thad Cochran Center) has been extended until January 30. Students will have the opportunity to select either oral or poster format for their presentations. Abstract guidelines can be found at http://www.usm.edu/graduate-school/graduate-student-research-symposium. Please encourage students to participate.

2. Graduate Coordinator/Program Manager Workshops
   - Informational workshops featuring round table discussions and case studies that highlight commonly-faced student and policy issues will be the format of Graduate Coordinator/Program Manager workshops. Graduate School staff will be present to answer questions. Two sessions will be offered in hopes of avoiding conflicts with teaching schedules. Attendance is very important.
     - Date and Time: Wednesday, Feb. 4, 1:00 – 3:00 PM or Thursday, Feb. 5, 1:00 – 3:00 PM
     - Location:
       - Hattiesburg campus: Thad Cochran Center Room 216
       - Gulf Park, GCRL, and Stennis campuses: Videoconferencing will be available. More information will follow.

Operational Changes Promoting Improved Efficiency

1. Fee increases effective July 1, 2015:
   - The application fee for admission or readmission to all graduate degree and certificate programs will increase by $10 (from $50 to $60). Anticipating fee-paying applications in the neighborhood of 2500 based on 2013-14 data, this fee increase should raise our revenue by about $25,000.

   A $50 late fee for a missed deadline to apply for a degree will be imposed. The imposition of this fee will encourage students to apply for graduation on time, allowing Graduate School auditors adequate time to conduct degree audits. At present there is no penalty for tardiness, and students are not compelled to submit the degree
application on time. While collecting this fee will benefit Graduate School operations, incurring this fee would be self-inflicted. It is difficult to predict the amount of revenue that will be collected from this late fee.

2. Thesis/dissertation/capstone project review by Graduate School:

The Graduate Reader will no longer review theses/dissertations/capstone projects for grammar and accuracy of the bibliography. Those reviews are the responsibility of the major professors and graduate committee members. The Graduate Reader will limit her review to document formatting and spot checking for document quality. Documents that are poor quality will be returned to the student, the major professor will be notified, and the document will be moved to the back of the queue. The Dean will not sign these documents until she is assured of their high quality.

3. Plans of Study Spreadsheets:

Plans of Study spreadsheets will soon be removed from the Graduate School website. A generic Plan of Study fillable form that students will access online and complete with the approval of their major professor and committee members is under construction. This change will foster mentorship as students map out their required coursework with their major professors. It will eliminate the recurring problem of outdated program requirements remaining on the web and the liability issue that follows inaccurate information available online. With this change it will be very important for programs to maintain updated and complete plans of study information in the Graduate Bulletin.

4. Six Sigma recommendations:

Six Sigma analysis identified a number of factors that hold up admissions decisions and skew aging reports. Changes are being implemented to correct these issues. The following implementations are underway or in planning:

- Problem: Low GPA (< 2.5) applicants who are not eligible for admission frequently languish in departments.
  - Solution: Graduate School will issue a denial of admission and encourage enrollment in non-degree coursework.
  - Departments will still have access to applications for data collection.

- Problem: Applicants delay start date for 1 year. The delay occurs typically because of the need to retake the GRE, GMAT, or TOEFL. Some applicants remain in the queue for many months and even years.
  - Solution: Admissions Pro will flag the application for rejection at 365 days.

- Problem: Stakeholders complain about insufficient training opportunities for departmental users of Admissions Pro.
  - Solution: Offer different types of opportunities for training
    - Multiple group training sessions will be scheduled each semester
    - One on one training will be available upon request
    - An online tutorial will be constructed and posted for easy access
Problem: Programs delay making decisions on applicants
- Solution: Provide department chairs with aging data so they can understand the length of time applications remain undecisioned in departments.

Problem: Poor communication between Graduate School and departments. Departments complain that they are not well informed about policy and procedure and that they are not notified when new applications are ready for review.
- Solution: To assure departmental contact information is up-to-date, Kim Wyatt will send out an email during week one of fall and spring semesters requesting updated lists of program managers, graduate coordinators, and department chairs.
- Solution: Policy and/or procedural changes will be communicated to program managers, graduate coordinators, and chairs via email in a timely manner.
- Solution: Graduate coordinator workshops will be held annually.
- Solution: The Bulletin will be updated each year and continue to be available online.
- Solution: Graduate School staff will read through the Bulletin to identify “anchor” words that will allow better searchability of the online Bulletin.
- Solution: An automatic email will be sent to graduate coordinators and committee chairs when an application is ready for review.
- Solution: If an application is delayed at departmental/program level, the Graduate School will notify chairs that action is needed.

December Graduation Numbers:

Graduation counts for students completing degrees in August 2014 and December 2014 included:
- 82 Doctoral degrees
- 4 Educational Specialist degrees
- 481 Master's degrees
Oral Presentations

• Participants must choose to do an oral presentation OR a poster presentation
• Research presented at another conference is acceptable, however research conducted at another university will not be accepted.
• Presentations may have multiple authors but only one presenter
• Only 10 oral presentations will be accepted from each department.
• Oral presentations must include a PowerPoint presentation with at least one slide that includes the title.
• The title slide must include the following:
  o Title that matches the original title submitted with the abstract
  o List of authors with the presenter’s name underlined
  o Department name
  o College name
• Presentations must not exceed 10 minutes.
• The submission categories for oral presentations are by college (Health and nursing have been combined):
  o Arts & Letters
  o Education and Psychology
  o Health and Nursing
  o Business
  o Science and Tech
• Students must submit an abstract and title using the online “Abstract Submission Form” (http://www.usm.edu/graduate-school/graduate-student-research-symposium) by January 30th.
• Departments will receive an excel file that includes the name and abstracts of the students submitting from their departments. Departments must rank and submit the names of their top 10 oral presentations to usmgss@gmail.com and notify the approved presenters by 5pm on February 13th.
• It is up to the department how to judge and determine the top 10 oral presentations. In the past judging was based on abstracts, however, judging is now left to the discretion of each department.
Poster Presentations

- Participants must choose to do an oral presentation OR a poster presentation.
- Research presented at another conference is acceptable, however research conducted at another university will not be accepted.
- Presentations may have multiple authors but only one presenter.
- There is no limit to the number of poster presentations that each department can submit.
- Submission categories for posters are chosen by the discretion of the student:
  - Social/Education Sciences and Business
  - Physical Sciences and Mathematics
  - Life, Health, and Environmental Sciences
  - Arts and Humanities
- Each poster must include the following:
  - Poster title must match the original title submitted with the abstract
  - The abstract
  - List of authors with the presenter’s name underlined
  - Department name
  - College name
- Each poster must be 3 feet tall and 4 feet wide. Please see the poster guidelines included at the end of this document.
  - If you already have a poster from a previous presentation you may use that poster regardless of the dimensions.
- Students who choose to do a poster presentation must submit their abstracts by using the online “Abstract Submission Form” (http://www.usm.edu/graduate-school/graduate-student-research-symposium) by 5pm on January 30th.
- In the event we do not have enough poster submissions, you will be given the option to present your research as an oral presentation. Abstracts submitted in this situation will be eligible for consideration for the departmental award and the Yarborough award.

Abstracts

- Abstracts must not exceed 300 words. Those that do will not be considered.
- Abstracts must be submitted using the online “Abstract Submission Form” (http://www.usm.edu/graduate-school/graduate-student-research-symposium)
- Abstracts must not contain any graphics of any kind. This includes charts, tables, graphs, pictures, illustration, etc. Those that do will not be considered.
- Oral presentations
  - Please include the following in the heading of your abstract
    - College
    - Name
    - Department
    - Presentation title
- Poster presentations
  - Please include the following in the heading of your abstract
• Submission category
• Name
• Department
• Presentation Title

---

**Awards**

• **Oral Presentations**
  - Department winners:
    - Only oral presentations are eligible for the departmental award
    - $100 will be awarded to each departmental winner
    - Award will be split between graduate student authors as they determine
  - Yarborough Oral Presentation Award winners:
    - Winners will be chosen from the department winners
    - Winners will be judged during their presentation at the symposium
    - $250 will be awarded to the top presentation in each college category
    - Award will be split between graduate student authors as they determine

• **Poster Presentations**
  - Yarborough Poster Award winners:
    - $250 will be awarded to the top poster presentations from each submission category
    - Judging will take place at the symposium
    - Award will be split between graduate student authors as they determine
2014 Graduate Student Research Symposium Poster Presentation Guidelines
Poster entries will be judged based upon the quality of research, presentation skills, and the ability of the presenter to answer questions.

Example Poster

Each poster must include the following items in order to be eligible for the poster competition:
- Poster title must match the original title submitted with the abstract
- The submitted abstract
- List of authors with the presenter’s name underlined
- Department name
- College name

Printing your poster. Posters may be printed professionally or manually. The printing quality (i.e. professional vs. manual print job) will not influence the judging of the posters, however, presenters should keep in mind that text and graphics must be readily visible from at least 6 feet away for adequate poster viewing. Professional poster printing can be accomplished locally by contacting USM Copy Center Services or an external printing service such as FedEx Kinko’s ®.

How to print a full-sized poster using tiled printing. To mitigate the cost of printing a poster, one can manually prepare their own poster using a standard printer and 8.5”x11” paper followed by assembling the poster as shown below. This is known as tile printing and makes possible the assembly of a large poster from a standard sized printer.
Tile printing using Microsoft Publisher

- Create a poster template in PowerPoint (or other appropriate program)
  - The poster should be prepared electronically using the dimensions desired in the final poster. For example, to make a 48"W x 36"H poster using PowerPoint, Open a new document > select the Design tab > Page Setup > set width and height to be 48” and 36” respectively. You can then prepare your poster using these dimensions.

- Save poster as a .PNG image
  - File > Save As > Other Formats > Save As Type: .PNG

- Open Microsoft Publisher and create a custom page with same dimensions as poster
  - File > New > Blank Page Sizes > Create custom page size > Set width and height equal to poster dimensions e.g. 48”W x 36”H
  - Set margin guides to 0.0”
  - Paste .PNG image file of poster into Publisher and adjust size to cover Publisher document and Save

- Printing the poster
  - Print > Printing Options > Tiled > Print
Use print preview to see how the document will be divided into 8.5” x 11” pages. It should look similar to above tiled format poster.

**Note:** All printers include margins along the edges of each printed page. These can be trimmed prior to poster assembly to avoid the presence of gaps between each poster “tile.”

**Considerations when making your poster.** Poster presentations are a great opportunity for students and faculty to discuss research ideas in a less formal but organized setting. Keep in mind that the poster should be designed to promote dialogue between the presenter and the other attendees. This means that you shouldn’t simply “copy & paste” your research paper onto a poster template, but rather focus on the overall goals of your research and the steps taken to achieve those goals using a less technical manner. By doing so, you will have a better opportunity for conveying your research to those outside of your field while receiving potentially constructive feedback from your audience.